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Project Goals
Each project begins with a clear description

of the overall concepts that are explained
in the project; these goals closely match the
different “stages” of the project workflow.

client comments

The Project Meeting

Each project includes the client’s initial
comments, which provide valuable
information about the job. The Project
Art Director, a vital part of any design
workflow, also provides fundamental
advice and production requirements.

art director comments

project objectives

Project Objectives

Each Project Meeting includes a
summary of the specific skills required
to complete the project.

ctionscript
plan of what needs ©

ceting

Project 3: Gator Race

Real-World Workflow

Projects are broken into logical lessons or

“stages” of the workflow. Brief introductions at
the beginning of each stage provide vital foun-
dational material required to complete the task.
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Step-By-Step Exercises
Every stage of the workflow is
broken into multiple hands-on,
step-by-step exercises.

2. Choose Insert>Layout Objects>Div Tag.

Visual Explanations
Wherever possible, screen shots
are annotated so students

can quickly identify important
information.

3. In the resulting Insert Div Tag dialog box, click the New CSS Rule button.
4. In the resulting New CSS Rule dialog box,

m Adobe Dreamweaver CS4

choose ID in the Selector Type menu.
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Visual Summary

Using an annotated version of the
finished project, students can quickly
identify the skills used to complete
different aspects of the job.
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‘The Against The Clock Portfolio Series teaches graphic
design software tools and techniques entirely within

the framework of real-world projects; we introduce and
explain skills where they would naturally fall into a real
project workflow. For example, rather than an entire
chapter about printing (which most students find boring),
we teach printing where you naturally need to do so —
when you complete a print-based project.

The project-based approach in the Portfolio Series
allows you to get in depth with the software beginning
in Project 1 — you don’t have to read several chapters
of introductory material before you can start creating
finished artwork. The project-based approach of the
Portfolio Series also prevents “topic tedium” — in other
words, we don’t require you to read pages and pages of
information about type (for example); instead, we explain
type tools and options as part of larger projects.

Clear, easy-to-read, step-by-step instructions walk
you through every phase of each job, from creating a new
file to saving the finished piece. Wherever logical, we also
offer practical advice and tips about underlying concepts
and graphic design practices that will benefit students as
they enter the job market.

The projects in this book reflect a range of different
types of animation and Web design jobs using Adobe
Flash and Dreamweaver. When you finish the seven
projects in this book (and the accompanying Portfolio
Builder exercises), you will have a solid foundational
knowledge of the two most popular applications in the
Web design market — and have a substantial body of
work that should impress any potential employer.

project 1

project 2

project 3

Rocket Ship Artwork

(d Using Layers to Develop Artwork
(d Drawing in Flash

(J Painting and Coloring

(1 Using Gradients

Ocean Animation

(1 Working with Graphic Symbols
(A Creating Animation

(J Defining
Button
States

Gator Race Game

(d Working with ActionScript 3
(d Creating Custom Functions
(J Working with Variables and Arrays

(d Scripting
Loops

J Adding Sound
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(A Using CSS to Control Content
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and Tables

(1 Fitting a Page
into an Existing
Site

Biltmore Web Site California Tourism Site
1 Working with Static Images (A Creating a Flash Video Module
J Creating Image Links

project 5

(A Creating an AP Web Layout
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[ Controlling Backgrounds with CSS
J Editing

Images in
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J Working with

Other Image

Types

Vii



ACKNOWLEDGEMENTS 11
WALK-THROUGH 1\
PRrRoJECTS AT A GLANCE VI

THE FLASH CS4 User INTERFACE 1
Navigating Menus in Adobe Creative Suite Applications. . ........ ... ... ... .. ... ... 1

Explore the Flash Interface .. ... ... e 2
Identifying and Accessing Tools in Flash . .. ... ... o o 7

Create a Saved WOrkspace . . .« ..ottt 8
Customizing Flash Behavior ............. . 9

Explore the Flash Document Window. .. ... e 10
Understanding the Flash View Options ...... ... ... .. .o i 12
Managing Multiple Documents. . ... ... i 14
Project 1 RockeT SHIP ARTWORK 15
Stage 1 Setting up the Workspace. . ... ... ... .. . 17
Create a New Document. . . ... 17

Import Objects from Other Programs . . ...t 18

Bitmap Images vs. Vector Art. ... ..o 19

Change Document Properties . ... ... ...ttt e 20

Align ODBJects . . oo ot 20

Aligning Objects to Each Other . ... ... oo 21

Stage2 Using Layers to Develop Artwork . ... ... ... . 22
Create Layers for Organizing Artwork. .. ... o 22

Organize Layers into Folders. . .. ... ..o 23
Expanding and Reducing the Timeline . .. ....... ... . o o 24

Stage3 DrawinginFlash .. ... ... . ... . 25
Destructive vs. Non-Destructive Editing . . . ........ .. .. . o i i 26

Use the Oval Tool to Create Shapes. . ... ..ottt e 27

Work with the Line Tool . . .. .ot 30
Drawwith the PenTool. .. ... o 32

Pen TOOL BaSiCs « .« v vttt ettt e e 35

Work with Anchor Points and Curves . .. ...ttt 36

Use Groups to Control the Interaction between Objects . .. ... i i, 39

Use the Pencil Tool . ..o oot 42

Drawing Preferences ... ... .. ... 44

Cut, Copy, Paste, and Paste in Place .. ... ... i 45

Use Strokes to Create Complete ODJects . . ..o vttt e e 48

Using Rulers, Guides, and Grids . . ... ..o 49

Editing Line Properties . ... ... i 50

Convert Strokes to Fills . . . ..o o oo 51

viii



Stage4 Paintingand Coloring ......... ... . ... ... . . L 52
Fill Artwork with the Paint Bucket Tool ..... ... ... o o i 52

Change Stroke Colors with the Ink Bottle Tool . . ................ oo o i 54

Use the Eyedropper Tool . . . ..ot 55

Using Outline View. ... ..o 58

Use the Brush Tool . . . ..o 59

Brush Tool Options. . . ..o oot e e 61

Add Backgrounds . . .. ... 62

Stage5 Using Gradients. . ...... ... .. ... . 63
Apply a Standard Gradient to Selected Objects .. ........ ... .. i 63
Softening the Edgesof a Fill .. ... ... . 63

Change the Direction of a Gradient. . ... ... ... 65

Editing Gradients . ... .. .oouuu 65
Transforming Gradients. . .. ... 66

Use Radial and Custom Gradients. . .. ...t e 68

Project Review. .. ... ... . . 71
Portfolio Builder Project . ....... ... ... 72
Project 2 OceAN ANIMATION 75
Stage 1 Working with GraphicSymbeols. . ... ... ... . ... ... . 77
The Library Panel in Depth. ... ..o 77

Import Adobe Illustrator Arework . .. ... 78

Import Files to the Library ... ... .. o 82
Mlustrator and Photoshop File Import Preferences. . ... ... 85

Copy Assets from an External Library . . ... ..o 86
Convertan Object toa Symbol. . ... o 88

Free Transformations . . . . ..o vttt ettt e 91

Using the Transform Panel. . . ... ... 92

Use the Spray Brush .. ... 93
Transformations in the Modify Menu . . ... ..ottt 93

Edita Symbolin Place. . ..ottt 95

Using Different Symbol Editing Modes. . ............ 98

Edit Symbol Properties . . .. ..ot 99

Organize Your Library with Folders. . ... .. ... o 102

Stage2 Creating Animation ............. ... ... .. 104
Create a Basic Frame Animation in a Movie Clip Symbol . ............ ... ... .. o ... 106

Animate a Graphic Symbol . . ... 109

Create an Object-Based Animation . ........ ... i 113

Edit the Shape of the Motion Path .. ... .. ... o 116

Motion Tween Properties and Presets. . ... ... 119

Use the Motion Editor ... ... 120

Using Onion SKIns . .. ..ottt e e 122
Controlling Animation Speed with Easing ......... ... ... ... ... . . o il 123

The Motion Editor Panel in Depth . ... ... oo o oo 126




Work with the Bone Tool ... ... o 127

Animate the Bone Armature ... ........ ... 130

Creating and Controlling Shape Tweens . ... ...t i e 133

Animate Effects and Filters . ... 134

Animate in 3D ... 138

Stage3 DefiningButton States. ....... ... ... ... 140
Create Button Symbols . . . . ..o 141

Use Hit States . .. oo ot 144

Prepare Symbol Instances for ACONSCIIPE « . ..o v vttt e 145

Project Review. ... ... ... . . .. 148
Portfolio Builder Project . ...... ... .. ... . 149
Project 3 Gator RAcE GAME 151
Stage 1 Preparing for ActionScript ........ ... ... 153
Review the File Structure. . ... ..o o 153

Define Instance NameS . . . . oo v vttt ettt et e et e e e e 155

Add Motion to the Background. . . ... ... .. . . . 156

Move the Starter Off the Stage. . .. ... o 159

Stage2 Working with ActionScript3. ... .. ... ... 161
Planning Your Script.. ... ... 162

Use Functions to Control Movie Clip Timelines . . . ... i it 162
Understanding the Actions Panel. .. ... ... o 164

Getting Help in the Actions Panel ...... ... ... . . 167

Use Functions to Loop Frame Animations. . . .......... ... .. .. 168

Use Scripting to Control Object Properties . . . ..« vvvnn ettt 172

Stage 3 Creating Custom Functions. .......... .. .. ... ... . ... i i 175
Create an Event Listener . . .. ..o 175

Define a Custom Function ... ... .. e 177

Stage 4 Working with Variablesand Arrays........... ... ... . .. ... i 181
Script with Variables and Random Numbers . ...... .. ... .. i i i 181
Translating ActionScript to Plain English . ... ..o o o oo 185

Create an Array to Store Object Positions .. ...... ... .. i 186

Stage 5 ScriptingLoops. ... ... .. . . . 188
Define a for...in Loop to Evaluate Array Elements ............ .o o i, 189

Use an If Else Condition to Call Movie Clip Frames. .. ....... .. oo i, 193
Translating ActionScript to Plain English, Part 2. . ... ... o oo oo o 193

Program the Restart Button Functionality. . ........ ... ... . o i 197

Test the Movie and Change Cursor Styles . . ... i 200

Stage 6 Adding Sound with ActionScript. ....... ... . .. . . 202
Create Access for Sound Files in the Library ... ... o oo 202

Create Scripts to Call Sounds .. ... 204

Publish the Final Movie. . . .. ..ot 207

Export Movie File Types . .. ..ottt 208
Understanding Publish Settings . ... i 210

Project Review. . ... ... . 212
Portfolio Builder Project . ...... ... .. ... .. . . . . . 213




THE DREAMWEAVER CS4 USER INTERFACE 215

Explore the Dreamweaver Document Window . .. ...t 216

Preview Files in Dreamweaver and Browsers .. .. ........ ..ottt 221

Using Live View .. ..o 222

Browser Preferences. . ..o vt it 223

Remove the Site from Dreamweaver . . ... ...ttt 224
Project 4 DiciTAL Book CHAPTER 225
Stage 1 Preparingthe Workspace . ....... ... ... ... . . 227
Create a Site Definition. ... ...t 227
Advanced Site Definition Categories . . . . ... v v vuuutt e 229

Create a New XHTML DOCUMENT .« .« . oot vttt ettt e e ettt 230
Understanding File Names and Document Titles. . .. .......... . o oo 231
(XOHTML VeISIonS . . . . oot ettt e e e e e e e e e e e e e e 232

The Files Panel In Depth . . .. ..o oot 233
Managing Files and Folders in the Files Panel ............... ... ... ... ... ... .. ..., 234

Paste Content in Code VIEW . . ..ottt e e e e e e 235

Element Names, Tags, and Attributes .. ... ... o 236

Structure is Visual Formatting — Plus a Whole Lot More. . ............ .o o i, 238

Stage2 Working with Special Markup ........ ... ... . .. .. 238
Format Lines of Text as Paragraphs .. .......... .. ... 238
Controlling Code Hints . ... ... 241

Create a Heading in Code View . ... ... .. 242

Headings and Search Engines . ..... . .. . . 243
Understanding Code View Formatting ... ..... . i 244

Format Heading Levels in the Properties Panel . ........ ... . ... . i i, 244
Formatting Text with the Properties Panel . . ........... ... ... ... . o 247
Formatting Inline Quotes with the q Element. . ...... ... .. o oo oo oo 248

Format a Block Quote and Inline Quotes . . ... 249

Using the Tag Chooser to Add aq Element. . ... . oo i i 249

Formata Citation . .. ... ..ot e 250

Mark Up Abbreviations in Code VIew. . .. ..ottt e 251

Mark Up Acronyms in Design View .. ... oo 254

Format with Strongand Em Elements. .. ......... . . o o 255

Stage 3 Working with HTML Character Entities . .. ............. ... ... ... ............... 257
Using the Text Insert Panel .. ... ..o o 257

Insert Special Characters . . . ... v 'ttt e 258

Insert Special Characters Manually . ... 260

Stage4 CreatingListsandTables. .......... ... ... ... . ... ... . ... . il 262
Create an Ordered List of Web Resources .. .....oouuiinin i 262

Methods for Creating Links. . ... ... 264

Using Relative Pathsin Links .. ... 265

Create a Definition List. .. ..ottt 266

Create a Table of Quotation Characters. . . .. ..ottt it 268




Stage 5 Fitting a Pageinto an Existing Site . . ......... ... . ... .. ... ... . i 271
Add the Header Paragraph. . ... ... o 271

Add the Footer Paragraph . ... ...... ... 273

Create a List of Links. . . . oo oottt 274

Prepare the Unordered Lists for CSS .. ... ... 276

Wrap the Contentina<div>Tag . ... ... 278

The Role of DivTags for CSS .. ..o 279

Attach the CSS File . . ...t 280

Project Review. . . ... .. . 282
Portfolio Builder Project ....... ... .. ... ... . . . . 283
Project 5 BiLtMore WEB SITE 285
Stage 1 Working with StaticImages. . ... ... .. ... . ... ... .. ... 287
Define the Biltmore Site . ... ...ttt 287

Insert Graphic Text Using the Common Insert Panel. . . ... ... ... ... ... 289

The Image Properties Panel .. ... ..o 292

Replace One Image with Another .. ... ... . o 293

File Formats for Web Graphics ....... ... ... 294

Insert an Image from the Files Panel .. ... .. . o 295

Color Depth and Image Format . ... i 295

Stage2 CreatingImageLinks. ... ... ... .. . i i i 297
Use Image Links in a Navigation Bar. .. ........ ... oo 297

Create a Header Image Link . ... ... ..o 299

Create Title Attribute Text. . . . ..ottt e 301

Ale Text, Title Text, and Tool Tips . . ..ot vttt e e e 303

Insert an Image with an Empty Alc Actribute. .. ... o o oo 304

Stage 3 Controlling Backgroundswith CSS . ......... ... ... ... .. ... .. . ... ... ... 305
Insert a Background Image in the Footer. .. ... ... .. . . i 305

Set the Background Color of the Navigation Bar ........ ... ... ... . i i 308
Hexadecimal Color Codes. .. ...ttt e 311

Use Repeat and Position Background Properties . ........... ... ... . . o i i L. 312

Stage 4 Editing Imagesin Dreamweaver .............. ... ... .. ... ... .. . i, 316
Cropanlmage. . ... ... o 316

Resize, Resample, and SharpenanImage. . . ... ...t 319

Finish the Photo Gallery for the Alabama Room .. ...... ... ... . i, 322

Set Image Transparency . .. .. ...ttt 323

Stage 5 Working with Other Image Types ......... ... ... ... .. ... ... .. . ... ... ... 326
Insert a Flash Animation . .. ... ... o 326

Insert and Configure a Flash Slideshow . ... ... oo i 329

Insert a Flash Video. . . ..o oo 332

Add a Favicon . ..o 334

Project Review. . . ... ... . e 336
Portfolio Builder Project ... ... ... ... 337

Xii



S
Project 6 SHowcoLATE CSS LAvout 339

Stage 1 Creating Layouts with StyleSheets . . . ... ... ... ... . ... ... ... L. 341
Define a Tracing Image . . ... ... ..o 341
The Page Properties Dialog Boxin Depth . ... ... .. oo 345
Create an External CSS File. . ... ..o 346
The CSS Styles Panel in Depth . ... 348
Create ID Selectors . . ..ot te 350
The CSS Rule Definition Dialog Boxin Depth. . ... ... .. ..o o o oo 353
Understanding the CSS Box Model. ... ... . o 355
Create a Layout with Div Elements. . ... ... ... 357
Comparing the <span> and <div>Tags . .. ... 361
Edit CSS Rules to Adjust the Layout. . . ..ottt 362
Use the Float Property to Control Nested Divs . ... ..o 366
Use Margins and Padding to Affect Element Placement. . .............. ... ... . o o ... 372

Stage2 Using CSS to Control Content. .. ......... ... .. ... ... ittt 375
Define Properties for the <body>Tag .. .. ... 375
Define HTML Tag Selectors . . ... ..o oottt 377
Place Common Page CONtent . .. ...ttt 379
Grouping Selectors . ... ... ... 379
CSS Mode of the Properties Panel . .. ... ... 383
Create Compound Tag Selectors . .. ... 384
Create Pseudo-Class Selectors . .. ...t 387
Create a Template File. . ... oo 389
The Modify>Templates Menuin Depth . ... .. i 391
Add and Modify Selectors to Meet Design Requirements . ............ .. ... ... ......... 393
The Insert>Template Objects Menuin Depth .. ... oo oo 393
Device-Specific Cascading Style Sheets ... ... i 396
Create the Navigation Links and Finish the Site ........... . o oo i 397
Project Review. . . ... .. .. . 399
Portfolio Builder Project . ...... ... ... ... . . . . 400

Project 7 CALIFORNIA TouRISM SITE 403

Stage1 CreatingaFlash VideoModule . ....... .. ... . ... ... .. . ... ... ... ... ..., 405
Import Video into Flash .. ... o o 405
Define FLVPlayback Component Parameters .. ........uuuttttiitnn e, 411
FLVPlayback Component Parameters . ... ... oottt 412
User Interface COMPONENTS. .« v ..t vttt ettt et et e e et e e e e e e 414
Use the TextArea Component for Captions. .. ...ttt 414
TextArea Component Parameters . . ... ..ovet ittt ettt 416
Add Thumbnail Navigation ODbjJects . ... ..ottt 417
TileList Component Parameters .. .........u ittt 418
Add Content to the TileList COmPONent. . ...« ..vvtt ettt e 419
Adjust TileList Parameters . . . .. ... ..ottt 421
Use a Change Event to Link Images, Movies, and Captions. . ..., 423

Edit an Interface Component SKin . ........ ... 426




Xiv

Stage2 Creatingan AP Web Layout. . ......... ... .. ... ... . . . . 429
Define the California Site ... ....... ... 429
Define a Fixed Background Image. . . ....... ... . . . 430
Insert AP DIvs. . . oottt 432
Use the Drawing Method to Createan AP Div . ... o i 435
Edit the Video Module File Paths . ... ... 440
CreateaSpry Menu Bar ... ... 443
Modify Menu SubItems. . . . ..ottt 446
Manually Edit Menu Bar List Ttems. . .« ..o oot 449
Use the Code Navigator to Review Related Styles .. ... o i o oL 452
Manually Edit CSS Selector Code. ... ... o 454
Use Code Hints to Write CSS Code . ..o v i i e 455
Use Live View to Review Behavior. ... ... ... o 458
Change Z-Index Values to Control Stacking Order....... ... i i 461
The AP Elements Panel in Depth. . . ... ... 462
Define Remote Connection Info forthe Site. . ... ... i i 464
Upload Files toa Remote Site . .. ... 466
Project Review. . . ... ... 469
Portfolio Builder Project ... ... ... . i 470




PREREQUISITES

The entire Portfolio Series is based on the assumption that you have a basic understanding of how to use
your computer. You should know how to use your mouse to point and click, as well as how to drag items
around the screen. You should be able to resize and arrange windows on your desktop to maximize your
available space. You should know how to access drop-down menus, and understand how check boxes
and radio buttons work. It also doesn’t hurt to have a good understanding of how your operating system
organizes files and folders, and how to navigate your way around them. If you're familiar with these
fundamental skills, then you know all that’s necessary to use the Portfolio Series.

REesouRrcEe FILES

All of the files that you need to complete the projects in this book are on the provided Resource CD

in the RF_Web folder. This folder contains nine subfolders, one for each project in the book (includ-
ing the Interface chapters); you will be directed to the appropriate folder whenever you need to access a
specific file. Files required for the related Portfolio Builder exercises are in the RF_Builders folder.

The Resource CD also includes a WIP folder, which also contains (mostly empty) subfolders for each
project in the book. This is where you will save your work as you complete the various projects. In some
cases, the location of a file will be extremely important for later steps in a project to work properly; thats
why we've provided a specific set of folders with known file names.

Before you begin working on the projects in this book, you should copy the entire WIP folder to your
hard drive or some other recordable media such as a flash drive; when we tell you to save a file, you
should save it to the appropriate folder on the drive where you put that WIP folder.

SYSTEM REQUIREMENTS

As software technology continues to mature, the differences in functionality from one platform to an-
other continue to diminish. The Portfolio Series was designed to work on both Macintosh or Windows
computers; where differences exist from one platform to another, we include specific instructions relative
to each platform.

One issue that remains different from Macintosh to Windows is the use of different modifier keys
(Control, Shift, etc.) to accomplish the same task. When we present key commands, we always follow
the same Macintosh/Windows format — Macintosh keys are listed first, then a slash, followed by the
Windows key command.




The Against The Clock Project Portfolio Design
Awards are your chance to gain recognition for your
creative and technical design skills. Prizes range from
your work being displayed in the Against The Clock Web
Gallery, to cash prizes, to having your design published

in an upcoming ATC book.

The Project Portfolio Design Awards are designed
to test both your creative talents and technical skills.
Submit your Portfolio Builder project from any of the
Professional Portfolio Series books for your chance to
win. Entries will be judged on design quality, originality,

understanding of client needs, and technical skills.
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for complete contest details and rules, and to download
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